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1. Introduction 

1.1 iPECS Attendant Overview 
iPECS Attendant is a Windows® PC based application providing the iPECS-CM Attendant with a 
graphical user interface for simple access to attendant functions.  iPECS Attendant registers to iPECS-
CM as soft phone via an IP connection.  iPECS Attendant delivers voice to audio devices in or 
connected to the PC. 
 
For each tenant in the iPECS-CM, up to thirty (30) iPECS Attendants can be connected.  Major 
features of iPECS Attendant are listed in the chart below. 
 

 Function Features 

Standard 
Package 

Basic Calling Dial/Answer, Conference, Transfer, Pick up, Forwarding, Hold 

Attendant 
Manual Trunk Selection, Directory, Night Service, Chained Call, 
Dedicated key 

Information 
Calling/Called party information, Subscriber information, Alternative 
information, Call waiting display 

PC Icon display, Phone book, Call history 
Presence Presence Group Display 

   

Hospitality 
Package 

Calling 
Bath Call, Room cut off, Do not disturb/DND override, Room to room 
block, Line lock out, Serial call set, Message wait indicator, etc. 

Front-Desk  
Check In / Out, Room Status, Room swap, Charge account, Wake 
up set/reset, Wake up alarm, lock out alarm 
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2. Installation 

Installation of the iPECS Attendant for the iPECS-CM is a three (3) step procedure.  First, licenses for 
the iPECS Attendant must be installed in the iPECS-CM and the iPECS-CM configured using the WMS 
(Web Management Server) to support the iPECS Attendant.  iPECS-CM license and configuration 
guidelines are discussed in section 2.1.  Second, the iPECS Attendant application is installed on the 
Attendant’s PC and, finally, the iPECS Attendant is configured to register and operate with the iPECS-
CM.  Install and set-up of the iPECS Attendant are covered in section 2.2 and 2.3, respectively. 
 
Once the installation is complete, each user of the iPECS Attendant should be assigned an account, 
which determines the database access permission for a user.  Section 2.4 outlines the steps to 
establish individual Accounts starting with the initial login. 
 
 

2.1 iPECS-CM Configuration 
2.1.1 iPECS CM Licenses 
Prior to attempting to configure the iPECS-CM for the iPECS Attendant, appropriate licenses must 
be installed.  The licenses are installed via the WMS under the System Management tab.  The 
relevant licenses are: 

 
 CML-IPEXT  Applies licenses for the number of IP extensions to be connected.  This 

number must include the total number of extensions including any iPECS 
Attendant extensions to be installed 

 
 CML-IPATDS   Applies licenses for the number of iPECS Attendants to be installed. 

 
 CML-HOTEL  When the iPECS Attendant is used to support Hotel operation, the Hotel 

license must be installed 
 
 

2.1.2 iPECS-CM Attendant Extensions and Key Number 
The Extension number for the iPECS Attendant must be available in the Numbering Plan.  In 
addition, the rules for the Attendant Key Number must be assigned in the Numbering Plan.  The 
Attendant Key Number is the dialed number, such as ‘0’, that will call all Attendants of a Tenant as 
a group 
 
Related WMS Menu 
WMS>Data Management>Numbering Plan Information>Numbering Plan 
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2.1.3 iPECS-CM Virtual IP Gateway 
A Virtual IP gateway channel is required in the iPECS-CM to support the iPECS Attendant.  The 
VIPM (Virtual IP gateway Module) and sub-rack for iPECS Attendant are defined in the System 
Configuration page. 

 
Related WMS Menu 
WMS>System Configuration>System Config(Detail) 

 
 

2.1.4 iPECS-CM Attendant Configuration 
The iPECS-CM supports thirty (30) iPECS Attendants for each tenant.  The Attendant Attributes 
must be defined for each iPECS Attendant.  First, add the iPECS Attendant then modify the 
Attendant Attributes to assign a User ID and password used by the iPECS Attendant user for login. 

 
Use the steps and figure below to add a new iPECS Attendant in the WMS,  

1. Open “Data Management>Attendant Information>Attendant Attribute” menu 
2. Click “Add” button at the top of the window 
3. In the pop-up, enter the Tenant and serial number of the iPECS Attendant.  The serial number 

is a running count of the Attendants installed for each tenant and can be from 1 to 30. 
4. Enter the slot and channel number of the VPIM to be used for this iPECS Attendant 
5. For the Attendant Type, select “iPECS Attendant – Standard”. 
6. Click “Apply” button to create the iPECS Attendant Extension number. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.1.4-1 Adding an Attendant 
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Once created, the authentication information for the iPECS Attendant can be configured as well as 
enabling the Caller Id option for the iPECS Attendant. 
 
Use the steps and Figure 2.1.4-2 below to enter the iPECS Attendant attributes. 

1. Open "Data Management>Attendant Information>Attendant Attribute" menu in WMS. 
2. At the top of the Attributes window, click “Modify”. 
3. Enter the User ID and Password for the iPECS Attendant. 
 

Figure 2.1.4-2 Assigning iPECS Attendant Attributes 
 
 

2.1.5 iPECS Attendant Key Number 
Each Tenant must be assigned with an Attendant Key Number.  The Attendant Key number is used 
by subscribers to call the Attendants of the Tenant group. 

 
Related WMS Menu 
WMS>Data Management>Attendant Information>Attendant Key Number 
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2.1.6 iPECS-CM Hotel Attendant/Front Desk 
When used with the Hotel Package, the Extension number of the iPECS Attendant should be 
configured as a Hotel Attendant.  This allows the iPECS Attendant to act as a Hotel Front Desk 
phone with access to the many Hospitality features common to a Hotel Front Desk phone including 
Check-in/Check-out, Wake-Up calls, Room Charges, etc. 
 
To assign the iPECS Attendant Extension for Hotel service, in the WMS select the Hotel Extension 
Attributes under the Hotel Information selection of Data Management and enter the Tenant and 
Extension number of the iPECS Attendant.  In the Hotel Extension Attributes, set the Hotel Service 
Type to Hotel Attendant, see Figure 2.1.6-1 below. 

Figure 2.1.6-1 iPECS Attendant Hotel Service 
 
 
 
 
 
 
 

Hotel Service 
Type 
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2.2 iPECS Attendant Installation  
2.2.1 PC Requirements for iPECS Attendant 
iPECS Attendant is a Windows® PC application that can run under any of the Operating Systems 
listed below: 
 Windows XP Service Pack 2 or higher 
 Windows Vista 
 Windows 7 
 
The recommended PC hardware is described below: 
 1 GHz CPU Clock speed 
 10 GByte main memory 
 100 GByte Hard Drive 
 CD/DVD ROM 
 1280 by 1024 pixel display resolution 
 Large display, 14” minimum recommended 

 
 

2.2.2 iPECS Attendant Installation 
Installation of the iPECS Attendant employs an Installation Wizard that will guide you through the 
installation process and will place the iPECS Attendant icon on the PC desktop.  The iPECS 
Attendant application must not be installed on the same PC with other iPECS soft clients (Phontage 
or iPECS UCS client).  To install iPECS Attendant, 
 

1. Download the iPECS Attendant software from the Partner portal of the Ericsson-LG 
Enterprise Web site.  The software includes the application and two supporting applications, 
WinPcap and Firebird, which are required. 

2. Locate and run the iPECS Attendant executable (.exe) file from the download. 
3. Follow the Wizard instructions to install the application. 
4. Install the WinPcap 4.1.1 application. 
5. Install the Firebird 2.1 application with the following setup configuration: 

 
 
 
 
 
 
 
 
 
 
 
 

WinPcap provides for capturing packets from the iPECS-CM.  Firebird provides for database 
operation.  Both WinPcap and Firebird must be properly installed for proper operation of the iPECS 
Attendant. 
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2.3 iPECS Attendant Initial Setup 
Once installation of the iPECS Attendant is complete, the soft client must be configured for 
operation with the specific iPECS-CM.  The iPECS Attendant should be configured with the host 
system information, User Id and password, PC IP address and database location.  To set-up the 
iPECS Attendant, 
 

1. Open iPECS Attendant program, click the         icon. 
2. In the Login screen, click Setting. 

 
 
 
 
 
 
 
 
 
 
 
 

3. In the System Connection page, enter the following option: 
a. Select PBX Type: iPECS_CM 
b. Enter System IP address: IPv4 address 
c. Select Connection Mode 
 Local: same subnet w/iPECS-CM 
 Remote: different subnet 
d. Enter PBX ID and Pwd 

4. Click Apply when done. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note the PBX ID and PBX Pwd must match the Attendant Attributes User ID and Password defined 
in the iPECS-CM database, see section 2.1.4. 

iPECS Attendant
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1. In the Database Setting page, select the database location (Local or Remote) and Enter the 
path and filename for the Database.  The default after installation is C:\Program Files\iPECS 
Attendant\DB\IPECS_DB.FDB.  If remote, enter the IP address as the first part of the path. 

2. Click Apply when done. 
3. Click Test button to verify database access. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When employing a remote database (not recommended) the remote PC must be operating and 
accessible for the duration of the installation and operation of the iPECS Attendant. 

 
 

2.4 Account Set-up 
IP Attendant can support multiple users with different PBX login credentials (PBX ID and password).  
Each user is assigned an IP Attendant account based on the PBX login credentials that will 
determine future access to the ‘Account’ menu.  At least one Supervisor account must be defined. 

 
2.4.1 Login 
Once the Settings outlined in section 2.3 are complete, the 
user may Login. 
 
To Login, 

1. Return to the login window. 
2. Enter the Attendant ID and Password. 
3. Then, click Login. 

 
When Login is selected, the following occurs: 
 iPECS Attendant Application executes 
 iPECS Attendant logs into the Databases 
 iPECS Attendant logs in to the iPECS-CM 
 iPECS Attendant loads the active language files. 
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 iPECS Attendant gets database information. 
 iPECS Attendant displays the Main Window, see section 3. 
 
Each of these steps is displayed in the “iPECS Attendant Initialize” window. 
 
 
 
 
 
 
 
 
 
 
 
Note you may configure the Login to save your ID and password or even login in automatically.  
Check the Login option boxes as desired prior to Login. 
 
Conditions 
 During Login in two failure types may occur; a database login failure (Login…db fail), which is 

due to a mismatched Account Name or Password, or a system login failure (system fail), which 
is due to a mismatched Attendant User Id and password.  The later is from the Attendant 
Attributes, see section 2.1.4. 

 After initial installation and start-up, the User should create an iPECS Attendant account to 
control access to the database, see section 2.4.2. 

 
Related WMS Menu 
Data management > Attendant Information > Attendant Attribute>  1. User ID (iPECS ATD), 
          2. Password (iPECS ATD) 

 
 

2.4.2 Set-up Supervisor Account 
When first installed, a temporary Supervisor Account is established with the default ID (admin) and 
Password (1111).  This default Account is deleted when the user assigns a Supervisor Account.  
Only a Supervisor level Account can add, delete or modify an Account. 
 
To assign an Account, 

1. Click the ‘Tools’ Menu in the upper left of the iPECS Main Window, see the following figure. 
2. Select the “Accounts” item. 
3. Select the “Add” button. 
4. Fill in the appropriate data, for “Perm” select Supervisor. 
5. Click Save. 
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It is recommended that the number of Accounts not exceed fifty (50).  Accounts can be modified 
using the Modify button.  One or multiple Accounts can be deleted using the delete and Shift + 
arrow or Ctrl + right mouse button on the PC. 

 
iPECS Attendant Main Window 
The iPECS Attendant Main Window, shown below, is divided into a number of functional areas or 
windows.  From top to bottom, left to right, these include: 

 Main Menus (File, Tools, Settings, Function and Help) 
 Status and Info Line - Mode Status (Day or Night), Alarms and Logout 
 Wait/Hold window 
 Group Monitor window 
 Search Phone Book/Call History windows 
 iPECS Phone Control window 
 Flexible Function buttons 

 
This section discusses major aspects of each section of the Main Window. 
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2.5 Main Menus 
The Main menus are shown in the top left of the Main Window. 

 
 

2.5.1 File Menu 
The ‘File’ Menu includes. 

 
 
 
 
 
 

Import 
Import an ACT!, Goldmine or Excel file to be added to the existing iPECS Attendant Phonebook.  
Only new entries are added.  The iPECS Attendant must be in the Night mode and the Database 
Setting must be “Local”. 

Export The iPECS Attendant Phonebook can be exported to an Excel file. The iPECS Attendant must 
be in the Night mode and the Database Setting must be “Local”. 

Logout Terminates the user’s session with IP Attendant, the application remains active awaiting a login. 
Exit Terminates the iPECS Attendant Application. 

 
 

2.5.2 Tools Menu 
The Tools Menu includes  

 
 
 
 
 

Monitor 
Group 

The Monitor window displays the members of a Monitor Group.  Add or modify up to three 
groups of up to 100 Extensions/Trunks each.  A Vacant number cannot be added to the group.  
Route Option BLF Usage and Tenant LED Information must be defined to display Trunk and 
Extension status, respectively. 

Account 

The iPECS Attendant can have multiple Users.  Different users employ different Accounts to set 
menu access.  The default Supervisor Account name (‘admin”) and password (“1111”) are 
available when no Supervisor Account is defined.  Use this account to assign a Supervisor 
Account during set-up. 

Phone Book Add, modify or delete entries in the iPECS Attendant “Local” Phonebook.  Multiple entries can be 
deleted [Shift + arrow or Control + left mouse button]. 

Call History Search, save, call or delete entries in iPECS Attendant Call Logs.  Three reports, listed below, 
are available.  The report can be saved as an Excel file. 

 IAll Call Call History (Log) report displays Incoming and Outgoing calls based on the Time and Call Type 
entered as the search criteria.  Individual or multiple Log entries can be deleted. 

No Answer 
IC Call 

Call History (Log) report displays No Answer Incoming calls based on the Time and other search 
criteria.  Individual or multiple Log entries can be deleted. 

Filtered with 
Number 

Call History (Log) report displays searched by selected number calls based on the Time and 
other search criteria.  Individual or multiple Log entries can be deleted. 
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2.5.3 Setting Menu 
In the Setting menu are  

 
 
 
 
 

In the Custom Setting window, the selections include: 
 

System Connection 
Information identifying the host iPECS-CM and environment must be defined to establish 

a connection with the host. 

Audio Setting 

Various audio devices can be configured and tones files can be assigned.  Tone files are 

in the .wav or mp3 formats. 

Sound device for RING / DTMF 

Sound device for Communication  

Enable Echo Cancellation 

Microphone Volume (Auto Mic Gain Control) 

Ring Sound File  

Video Setting  
Video frame rate :   VeryHigh-15 frame   /    Max-30 frame (default) 

support QCIF  / CIF  

Video Codec - H.263 

Display Options 

Display options allow the user to modify the appearance of several windows including the 

Monitor Window and the Phone Book window.  The former can display other 

Extension/Trunks as small or large icons or a simple list.  The Phone Book window can be 

shifted to a Quick Search window. 

Message Trace 

The “Trace” option can be run if the iPECS Attendant is performing poorly.  Do not 

activate the trace option unless instructed to do so by your technician.  The trace, when 

set, can be in-detail or summary, and is sent to the file C:\Program Files\iPECS-

Attendant\Capture. 

Call Recording  Set call recording file directory 

Phone Book Set integrated phone book ( Outlook / LDAP) 

Headset Setting 
User can select connected headset (Normal/Plantronics/Jabra). Connected Headset 

driver should be installed. 

Database 
Setting 

The iPECS Attendant employs the database configured.  The location, Local or Remote 

and path w/filename are entered.  For Remote, the remote PC IP address is entered as 

the beginning of the path.  The remote PC must be maintained as operational during set-

up and operation of the iPECS Attendant 

 Local :  Firebird 

 Remote : User can select DB driver type  

                - FireBird 

               - MYSQL 

               - Oracle 

               - MS-SQL 
             User should input  the Server information such as  IP /  Database Name /  Name / PWD  
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 Call log Alarm – When the call log more than 300,000, sends a warning 

message. User can define call log count.  If amount of data is too much , 

system performance may be degraded. User should delete data when warniung 

message pop-up. 

 KeepAlive - When connect the remote database, send keep alive message to 

keep connection. 

In case that remote database and attendant is night mode, the database 

connection could be disconnected because user did not access the database 

for a certain period time. 
To prevent it, send keep alive message in every 5 minute. ( It is availale only in 

Attendant Night Mode) 

 
 Headset Setting  
iPECS-Attendant support headset integration. Headset driver should be installed in PC. When 
connected headset, User can select headset type. In order to use all headset functions by selecting 
one of headset types in the “Headset Setting” menu, install “Jabra and Plantronics” in the “Drivers” 
folder and do the relevant settings 
 
 Plantronics Installation 

Install “Plantronics” by double clicking the “PlantronicsURE-SDK.msi” file in “C:\Program Files\iPECS 
Attendant\Drivers”.  
 
 
 
 
 
 Jabra Installation  

Install “Jabra” by double clicking the “JabraPcSuiteSetup.exe” in “C:\Program Files\iPECS 
Attendant\Drivers”.  
Click the right button of the mouse on the “JabraCOMObject.reg” file and the click the “Merge” menu 
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2.6 Status and Info Line 
Below the Main Menus, is the Status and Information Line that includes the Day/Night Mode control, 
Alarm indicators and the Log off button. 
 
 
2.6.1 Day/Night Mode Control 
The Attendant can control the Attendant mode from Day to Night to Day.  The ability to transition 
modes may be password protected in the iPECS-CM host.  While in the Night mode, calls to the 
Attendant are rerouted to the defined Night subscriber 

Day Mode     Night Mode 

          
 

To change the Mode from Day to Night 
1. Click the “Day Button” at the top right of the Main Window.  
2. Enter Password and dial “*” if passwords are enabled. 

 
To change the Mode from Night to Day 

1. Click the “Night Button” at the top right of the Main Window. 
2. Enter Password and dial “*”, if passwords are enabled. 

 
Related WMS Menu 
Data Management > Tenant Information > Tenant Basic Information> Tenant Attribute > Privileged 
feature access method  
Data Management > Extension Information > DN Attribute > Extension Password  

 
 

2.6.2 LED Display for Alarm 
To the right on the Status and Info line is the Alarm 
LED Display.  Alarms are indicated with a red color as 
described in the chart below.  Specifics of Alarm functions are configured in the host iPECS-CM. 

 
LED Description 
IF IF- Interface to iPECS-CM 

CT Critical Alarm in iPECS-CM 

MA Major Alarm in iPECS-CM 

MI Minor Alarm in iPECS-CM 

DB 

Location and status iPECS Attendant and Database: 
 Green = Local database Active 
 Blue = Remote dbase active 
 Red = Database connection failure 

 
Related WMS Menu 
Failure Management > Alarm Management > Alarm Information 
Failure Management > Alarm Management > Overall Alarm Report 
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2.6.3 Logout 
To the right of the Alarm LEDs is the Logout button.  Clicking the Logout button terminates the 
iPECS Attendant program and returns the Login window. 

 
 
 
 
 
 
 
 
 

2.7 Wait/Hold Window 
The Wait/Hold window presents records for calls queued to the iPECS Attendant (Wait) and calls 
held by the iPECS Attendant (Hold) in two distinct sub-windows.  The number of Trunk, Station and 
Recall calls is shown in the upper right of both sub-windows.  As an additional aid in identifying 
calls, a colored dot starts each call record.  A blue dot indicates a Station call, a green dot indicates 
a Trunk call and a red dot indicates a recall. 

 
As a default, the Attendant can have 15 queued calls, five (5) of each type, and five (5) held calls.  
The information for incoming calls is displayed in the Attendant Wait Queue and information for 
calls held by the iPECS Attendant is shown in the Hold window. 

 
To answer a call in either window, the Attendant simply double clicks the record.  Any active call is 
placed on Hold. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Related WMS Menu 
Data Management > Attendant Information >  1) Attendant Overflow Subscriber 
       2) Attendant Call Options 
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2.8 Monitoring Window 
The Monitor Window displays the real-time status of other Extensions and Trunks.  Monitor groups 
are defined in the Tools Menu.  The window employs different icons and colors as shown below for 
the Extension and Trunk status.  In addition to allowing click to call, placing the cursor over an icon 
provides additional information. iPECS Attendant provides 100 monitoring groups.  
In case of creating many groups, clicks the right button of the mouse on the group tap to use 
functions such as “First Page”/“Prior Page”“Next Page” /“Last Page” and “Goto Group” for effective 
monitoring. Goto Group is only functional only when there are more than 2 groups that have been 
created.  
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Extension status 
indications 
 

 
 
 
 

Trunk status indications 
 

 
 

Conditions 
 Both the Tenant LED Information and Route Options BLF Usage must be configured in the host 

iPECS-CM for proper status displays. 
 If a Monitor Group member Extension is Out-of-Service (OOS), the status for the group will not 

updated.  To display the group status correctly, remove the OOS Extension from the Monitoring 
Group. 

 
 
 
 
 
 
 
 
 
 

Idle DND CFwd Busy      Busy+ 

DND 

Busy+ 

CFwd 

OOS Error 

Idle Busy OOS 
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2.9 Search Windows 
2.9.1 Phonebook-Search Window 
Description 
Provides Quick Phone Book search with the “Station", "Name", "Company", "Department" and 
"Mobile Phone number". 

 
Operation 

1. Enter any number or characters into the Phone Book Search Field in the first line of Phone 
Book Window. 

2. Press “Enter” on keyboard or click the “Search” button. 
3. Double-click a Phone Book entry to place a call. 

 
 
 
 
 
 
 
 
 
 

 
 

2.9.2 Call History 
Description 
The call logs can be searched using date/time and type of call (In/Out). 

 
Operation 

1. Enter the search criteria in the Call History window, 
2. Press “Enter” on keyboard or click the 

“Search” button. 
3. Double-click an entry to place a call. 
 

 
 
Icon by Call Type 
 
 
 
 
 
 
 
 

Outging 

Incoming 

Recall 

No answer 
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2.10 Dial Pad Window 
The Dial pad window simulates the various buttons and display of the Ericsson-LG Enterprise desk 
phones.  The upper portion of the window is the LCD to display information on the active call.  
Below the LCD from left to right are the dial pad, Fixed Feature keys and Audio controls with Mute 
button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.11 Flexible Function buttons 
At the bottom of the Main Window are the Flexible Function buttons.  Each button is assigned a 
function.  The functions can be selected on screen or with the corresponding PC keyboard Fn 
buttons, F1 to F12. 
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2.12 Group Information 
User can make subscriber group information. Subscriber information is grouped for effective 
management & search.  Child group can be added  by step 5. If setting “Subscribers 
Information Display” as “Group Information” in the “Custom Setting” (Environment Setting), the 
relevant group infomration that has been set in the “Monitoring Group” is displayed and station 
numbers of the relevant groups are displayed in the “Subscribers Information Search” window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.13 Call Record Report 
User can record conversation using the  record button. File name is composed of  Recording time & 
dialed numbers. If user click file name, user can listen recored file. Default directory of the saved files 
is “C:\Program Files\iPECS Attendant. 
 
Press  the [Record] button during conversation. 
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2.14 Ring Device Selection 
when user wearing the headset, user can select incoming bell rings through the speaker or the 
headset.  
 

 
 

 

2.15 Video Call  
Attendant support vide call. Click the “Video” button during the phone call. 
Press [send to] button if you want to start to send video. 
Press [Stop] button if you want to stop. 
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2.16 Report & Statistics  
iPECS Attenant reports various call history(the history of incoming calls & outgoing calls & non 
response & check in/out & wake up) and display informations by graphic & report.  
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2.17 Outlook & LDAP Integration  
If  user want to is LDAP  or  Outlook integration for phonebook(subscriber information) , user should 
select it in database setting of  Custom setting menu. to be used. If selecting “Synchronize Phonebook”, 
the subscriber information in Outlook  is synchronized.(Synchronization is available only in night mode) 
If  user want to use LDAP integration, user should select  “LDAP Use” and Input the server information 
and click the “Test” button to see if connection has been done normally.  
 

Operation 
1) Database: DB information that has been set in the “Database Setting” is used.  
2) Outlook: Outlook address book is synchronized to be used.  

- If selecting “Synchronize Phonebook”, the subscriber information that has been collected 
from PBX is applied to Outlook.  

- In case of using “Outlook”, the function (“Menu” → “Tools” → “Phonebook” & “Synchronize 
Phonebook”) is only applicable to the night mode.  

3) LDAP: The information of LDAP server is used.  
- Check “LDAP Use”. 
- Input the server information and click the “Test” button to see if connection has been done 

normally. 
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3. iPECS Attendant Functions 

3.1 Extension Calling and Answer 
Description 
The iPECS Attendant can place and receive calls to/from other Extensions in the iPECS-CM host. 

 
Operation 
To place a call to another Extension, from the iPECS Attendant, 

1. Dial the Extension number or click the Extension icon in the Monitor window. 
2. When dialing, if the extension is idle, press the “Enter” button on the PC keyboard or click 

the “Connect” button. 
 

To answer a call from another Extension, from the iPECS Attendant, 
1. Answer the call with one of the following actions: 

Press the "Space Bar" on the keyboard 
Click the "Answer" button 
Double click the call record in Wait Window 

 
 

3.2 Call Release 
Description 
While processing a call or other feature, the iPECS Attendant can return to the previous step or 
terminate the action using the “Clear” and “Release” buttons, respectively. 

 
Operation 
To return to the previous step of an operation, from the iPECS Attendant, 

1. Press the “Clear” button. 
 

To cancel an operation, from the iPECS Attendant, 
1. Press the “Release” button. 

 
 

3.3 Trunk Calling and Answer 
Description 
The iPECS Attendant can place and receive calls over the iPECS-CM Trunk resources. 

 
Operation 
To place an outgoing Trunk call, from the iPECS Attendant, 

1. Dial a Trunk group access code. Or, 
press the “TRK SEL” function button and dial the Trunk serial number 

2. Dial the desired outside telephone number. 
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To answer an incoming Trunk call, from the iPECS Attendant, 
1. When a call is received, it will appear in the Wait (Queue) Window. 
2. At the iPECS Attendant, to answer the call, 

Press the Space bar on the PC keyboard or 
Click the “Answer” button, or, 
Double click on the call record in the Wait window. 

 
Related WMS Menu 
Data Management > Trunk Information > Trunk Basic Information > Trunk Access Code 

 
 

3.4 Verify Busy Status 
Description 
The iPECS Attendant Main Window includes a Dial pad window that includes an area that 
simulates the LCD of the typical desk phone.  The LCD area displays the status of other Extensions 
and Trunks when called. 

 
Operation 
To display the status of an extension from the iPECS Attendant, 

1. Dial the desired Extension number, the Tenant number, Class,  Extension number and 
status of the Extension is shown in the LCD area. 

 
To display the status of a Trunk from the iPECS Attendant 

1. Enter a Trunk group access code. Or, 
press the “TRK SEL” function button and dial the desired Trunk Serial Number, the Tenant 
number, and status is displayed in the LCD area. 

 
To display the status of and answer a Trunk call from the iPECS Attendant 

1. Click the "Answer" button; the call is answered and the LCD area displays the Caller Id 
based on the Caller ID options assigned in the Attendant Attributes of the WMS. 

 
To display the Call Forward status of a call, from the iPECS Attendant 

1. When a call forwards to the iPECS Attendant, upon answer, the LCD area will display the 
Caller Id of the original caller. 

 
Conditions 
 If Caller Id is not received for an incoming Trunk call, the Trunk serial number is displayed 

instead of Caller ID. 
 

Related WMS Menu 
Data Management > Attendant Information > Attendant Attribute > CID Display 

 
Relevant Features 
 Intrude 
 Conference Call 
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3.5 Trunk Selection 
Description 
The iPECS Attendant is permitted to select and access a specific individual Trunk. 

 
Operation 
To select a specific Trunk, from the iPECS Attendant, 

1. Click the "TRK SEL" button. 
2. Dial the 4-digit Trunk serial number. 

 
Conditions 
 To use this feature, a “TRK SEL” button must be assigned as a Flexible button. 

 
Related WMS Menu 
Data Management > Trunk Information > Trunk Basic Information > Trunk Access Code 

 
Relevant Features 
 Attendant Outgoing & Incoming 

 
 

3.6 Blind Call Transfer 
Description 
During a conversation, the iPECS Attendant can transfer the call to an Extension without awaiting 
the Extension to answer the transferred call.  This is also known as an Unscreened Call Transfer. 

 
Operation 

1. During an active call the iPECS Attendant dials the number or clicks the icon of the 
Extension to receive the transfer followed by ‘*’.  The active call is placed on Hold and the 
new call is placed. 

2. Click the "Connect" button, the call is sent to the Extension and the iPECS Attendant 
returns to idle. 

 
Related WMS Menu 
Data Management > Attendant Information >  Attendant Call Options > Hold Option on Call 
Transfer 

 
 

3.7 Consultation Transfer 
Description 
When transferring a call, the iPECS Attendant can consult with the receiving party prior to 
completing the transfer.  This permits the iPECS Attendant to assure the Subscriber will accept the 
transfer. 
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Operation 
To transfer a call with Consultation 

1. During an active call the iPECS Attendant dials the number or clicks the icon of the 
Extension to receive the transfer followed by ‘*’.  The active call is placed on Hold and the 
new call is placed. 

2. When answered announce the call then, the iPECS Attendant can:   
a. Press ‘*’ to return to the previous call.  By pressing ‘*’ the iPECS Attendant can switch 
back and forth between the calls (Broker Call),  
b. Press the “Release” button to disconnect the active call and return to the held party or 
c. Press the “Connect” button to complete the transfer; the call is connected to the 
extension and the iPECS Attendant returns to idle. 

 
 

3.8 Pilot Hunt 
Description 
When a busy extension is part of a Pilot Hunt Group, the iPECS Attendant can call or transfer a call 
to an available member in the same Pilot Hunt Group. 
 
Operation 
To call an idle Extension in a Pilot Hunt Group 

1. Dial or click the icon of the busy Extension and receive busy. 
2. Click the "GRP CALL" button. 
3. The call is routed to ann Extension in the same Pilot Hunt Group as the busy Extension and 

the iPECS Attendant hears "Ring Back Tone". 
 

To transfer a call to an idle extension in a Pilot Hunt Group 
1. Dial or click the icon of the busy Extension and receive busy. 
2. Click the "GRP CALL" button. 
3. The call is routed to an Extension in the same Pilot Hunt Group as the busy Extension and 

the iPECS Attendant hears "Ring Back Tone". 
4. Click “Connect” to connect the call to the Hunt Group and return the iPECS Attendant to idle. 

 
Conditions 
 To use this feature, a “GRP CALL” button must be assigned as a Flexible button for the iPECS 

Attendant. 
 

Related WMS Menu 
Data Management > Station Information > Group Information > Pilot Hunt Group 

 
 
 
 
 



iPECS Attendant 
Installation and User Manual Issue 1.4 

 

27 

3.9 Call Pick Up 
Description 
The iPECS Attendant can answer (pick-up) an incoming call routed to another Extension. 

 
Operation 
To answer a call ringing at another Extension, 

1. Enter the Extension number or click the Extension icon in the Monitor Window. 
2. Click the "PICK-UP" button” 

 
Conditions 
 To use this feature, a “PICK-UP” button must be assigned as a Flexible button  

 
Relevant Features 
 Cancel Last Call Transfer 

 
 

3.10 Call Pick Up between Attendants 
Description 
Incoming calls in the iPECS Attendant Waiting queue can be answered (picked up) by another 
Attendant in the same Tenant group. 

 
Operation 

1. At the iPECS Attendant, when a call queues to another Attendant, click the “Answer” button 
2. The call is answered by the iPECS Attendant and removed from the original Attendant’s 

Queue 
 

Related WMS Menu 
Data management > Tenant Information > Tenant Basic Information> Tenant Attribute>Pick Up 
between ATD  

 
 

3.11 Cancel Last Call Transfer 
Description 
The iPECS Attendant can cancel the most recent Call Transfer and reconnect to the transferred 
call.  This function can be useful should the Attendant transfer a call to a busy or wrong extension. 

 
Operation 

1. Before the Transferred call is answered, click the "Pick-Up" button, the call is connected to 
the iPECS Attendant. 
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3.12 Camp On 
Description 
When the iPECS Attendant transfers a call to a busy Extension, the Attendant can Camp the call 
on to the busy Extension. 

 
Operation 
To Camp a call to a busy Extension 

1. While on a call, dial the Extension to receive the transfer 
2. If the Extension is "BUSY", click the "Camp On" button 
3. The call is camped on to the Extension, both parties receive Camp-On tone and the iPECS 

Attendant returns to idle 
 
 

3.13 Conference 
Description 
An iPECS Attendant can initiate a 3-party conference call. 

 
Operation 
To initiate a Conference from the iPECS Attendant, 

1. Place first call as normal. 
2. While on the call, dial the desired Extension to join the conference. 
3. Click the "Conference" button; the initial call is placed on hold, the dialed Extension rings, 

and the iPECS Attendant hears "Ring-Back Tone". 
4. When the dialed extension answers, a 3-party conference is established.  

 
 

3.14 Hold and Connection 
Description 
The iPECS Attendant can have up to five (5) calls on Hold simultaneously and can retrieve the calls 
from the ‘HOLD’ window as required. 

 
Operation 
To place a call on Hold  

1. While on an active call, click the "Hold" button. 
2. Call Information is displayed in "Hold" window. 

 
To pick up a held call 

1. While idle, double-click a call held in the "Hold" window.  
2. Call is established with iPECS Attendant and held party. 

 
Related WMS Menu 
Data Management > Attendant Information > 1) Attendant Night Subscriber 
       2) Attendant Call Options 
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3.15 Overflow Service 
Description 
When the number of calls waiting in queue exceeds the iPECS Attendant Queue capacity, new 
incoming calls can be routed to a predefined overflow subscriber. 

 
Operation 
To activate Overflow service 

1. During "Day" mode, click the “OVF” (Over Flow) button. 
2. The "OVF" button will change to a blue color. 
3. Calls exceeding the iPECS Attendant Queue size route to the defined Overflow extension. 

 
To deactivate Overflow service 

1. During "Day" mode, click the “OVF” (Over Flow) function button. 
2. Calls exceeding the iPECS Attendant size receive busy tone. 

 
Related WMS Menu 
Data Management > Attendant Information > 1) Attendant Overflow Subscriber 
       2) Attendant Call Options 

 
 

3.16 Intrude 
Description 
As a default, the iPECS Attendant can intrude in to an existing call.  The connected party receives 
the Intrusion Tone before the iPECS Attendant is connected. 

 
Operation 

1. When the iPECS Attendant dials a busy extension, click the “INTRUSION " button.  The 
parties hear intrusion tone, and a three party call is established. 

2. At the iPECS Attendant, click the "Release" button to exit the call. 
 

Related WMS Menu  
Data Management > Attendant Information > Attendant Call Options > Intrusion 

 
Relevant Features 
 Conference Call 

 
 

3.17 Serial Call Transfer 
Description 
iPECS Attendant can maintain supervision of a transferred external call and can transfer the 
outside call to multiple Extensions sequentially.  The iPECS Attendant transfers the external party 
to an Extension.  When the receiving Extension disconnects, the external party is returned to the 
iPECS Attendant queue.  The iPECS Attendant can repeat a transfer to another Extension. 
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Operation 
To maintain Supervision of a transferred call from the iPECS Attendant 

1. While connected to the external party, dial the first Extension to receive the call 
2. Dial “#” instead of clicking the “Connect” button, the call transfers to the Extension. 
3. When the station releases the call, the call is returned to the iPECS Attendant. 
4. The iPECS Attendant can repeat the procedure to transfer the call to another Extension. 

 
Conditions 
 This feature is not available for internal calls. 

 
 

3.18 Collect Call Registration 
Description 
When transferring an incoming external call, the iPECS Attendant can request the subscriber 
accept charges for the call. 

 
Operation 
To activate and view Incoming Collect Call charges, from the iPECS Attendant 

1. While connected to an incoming external call, dial an Extension. 
2. Click the "CHARGE" button, the CHARGE button LED lights, the original call is held, the 

Extension receives ring and the iPECS Attendant hears Ring-Back tone. 
3. When the called Extension answers and accepts the “Collect Call”, click the “CHARGE” key 

again, the “CHARGE” button LED flashes. 
4. Input the outside telephone number and click the “ENT” button, the “CHARGE” button LED 

turns Off, the call is transferred to the Extension and the iPECS Attendant returns to idle. 
 

To verify the charges after the call, from the iPECS Attendant, 
1. When the Extension terminates the call, the "CHARGE" button LED lights again. 
2. Click the “CHARGE” button to verify the collect call information 
3. Click the “Confirm” button again, the “CHARGE” button LED turns Off. 

 
Conditions 
 The iPECS Attendant must have a Flexible button assigned to the “Charge” function. 
 This feature is enabled for each Tenant as the default. 

 
Related WMS Menu 
Data Management>Tenant Information 1) Tenant Attribute > ATD Call Charge 
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3.19 Through Dialing 
Description 
The iPECS Attendant may access and transfer an outgoing Trunk, transfer dial tone or an outgoing 
Trunk call to another Extension. 

 
Operation 
To transfer dial-tone to an Extension from the iPECS Attendant, 

1. While connected to the Extension, dial a Trunk Access Code, the Extension is placed on 
hold. 

2. Click the "Connect" button, the iPECS Attendant returns to idle and the Extension is 
connected to dial tone from a Trunk.  

OR 
1. Access an idle Trunk as normal 
2. Click the "Clear" button. 
3. Dial the Extension number. 
4. Click the "Connect" button, the iPECS Attendant returns to idle and the Extension hears 

"Dial Tone". 
5. The station subscriber dials the external telephone number.  

 
To transfer an activate outgoing call to an Extension from the iPECS Attendant, 

1. While connected to the Extension, dial a Trunk Access Code and external telephone 
number.  The Extension is placed on hold and the iPECS Attendant hears Ring-Back tone. 

2. Click the "Connect" button during or after connection to the external party, the iPECS 
Attendant returns to idle.  The Extension is connected to the Trunk, hearing either Ring-
Back tone or conversation. 

 
Related WMS Menu 
Data Management > Attendant Information > 1) Attendant COS on Through Dialing 
       2) Attendant Attribute 
Data Management > Trunk Information > 1) Trunk Basic Info > Trunk Access Code 
       2) Trunk Basic Information > Trunk Access Code 

 
 

3.20 Trunk Call Supervision 
Description 
Attendant can maintain supervisory control of a transit call. 
 
Operation 
To place a Transit call and maintain supervision from the iPECS Attendant, 

1. During an external call, transfer the call to another external number. 
2. After the assigned Transit Call Timer expires, the "SUPV" LED is flashes. 

 Click the “SUPV” button to connect to the call and view the call information in the LCD. 
 Press the “Release” button to allow the transit call to continue, the iPECS Attendant returns to 

idle and the Transit Call Timer restarts. 
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3. To release the transit call, click the “FORC RLS” button. 
 

Conditions 
 Transit service between two Trunk Route Groups can be limited.  
 The “Release Method” should be set to allow “Release by ATD Monitoring” 
 A Flexible button must be assigned for the “SUPV” function. 

 
Related WMS Menu 
Data Management > Trunk Information > Transit Service 

 
 

3.21 Forced Trunk Release 
Description 
The iPECS Attendant can change the status of a busy Trunk to idle, disconnecting any conversing 
parties. 

 
Operation 

1. Click the "TRK SEL" button. 
2. Enter the four (4) digit trunk serial number. 
3. The status of the selected trunk will be displayed. 
4. Click the "FORC RLS" button to return the trunk to an idle state. 

 
 

3.22 Wake Up Registration/Cancellation 
Description 
The iPECS Attendant can set or cancel Wake Up calls to other extensions. 

 
Operation 
To set the Wake Up time for an extension ( Single) 

1. Click [WAKE-UP] button. 
2. Check the “Single (Singular Number)”.  
3. Enter a room number & Click the “Enter” key. 
4. Select index (1~5). 
5. Select the type of Wake-up (Once, Everyday,  Mon~Fri, Mon~Sat, Date). 
6. Enter the hour of the Wake-up time (hour: HH). 
7. Enter the minute of the Wake-up time (minute: MM). 
8. In case the Wake-up type is “Date”, Enter 6 digits (YY/MM/DD) for year, month and day. 
9. Click [add] button in the box. 

 
To set the Wake Up time for an extension ( Muilti ) 
1. Click [WAKE-UP] button. 
2. Check the “Multiply ”.  
3. Enter a room number & Check “Enter” key. 
4. Select index (1~5). 
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5. Select the type of Wake-up (Once, Everyday,  Mon~Fri, Mon~Sat, Date). 
6. Enter the hour of the Wake-up time (hour: HH). 
7. Enter the minute of the Wake-up time (minute: MM). 
8. In case the Wake-up type is “Date”, Enter 6 digits (YY/MM/DD) for year, month and day. 
9. Click [add] button in the box. 
10. Set the station range of multiply (plural number) and click the [+] button. 
11. Click the “Save” button. 
12. Unusable numbers are displayed as red color and in order to delete them, click the right 

button of the mouse and select the “Vacant Delete”. 
 

To cancel the Wake Up to an extension 
1. Click the "WAKE UP" button. 
2. Enter the Extension number. 
3. In the pop-up, select Wake Up Registration. 
4. Click the "Delete" button. 

 
Related WMS Menu 
Data Management > Station Information > Number (DN) Information > DN Function Registration > 
Alarm Time 
 
Relevant Features 
 Alarm at Wake Up time 

 
 

3.23 Message Wait Registration/Cancellation 
Description 
The iPECS Attendant can activate or cancel Messages between Extensions. 

 
Operation 
To activate a Message from one Extension to another 

1. Click the "MSG WAIT" button. 
2. Enter the Extension number that will get the message. 
3. Enter the Extension number that wants to leave the message. 
4. Click the "ENT" button. 

 
To cancel a message from one Extension to another 

1. Click the "MSG WAIT" button. 
2. Enter the Extension number that has a message. 
3. Enter the Extension number that left the message. 
4. Click the "FORC RLS" or “ENT” button. 

 
Relevant Features 
 Message Wait/Reservation 
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3.24 Do Not Disturb Registration/Cancellation 
Description 
The iPECS Attendant can activate or deactivate DND (Do-Not-Disturb) at other Extensions. 

 
Operation 
To Activate DND (Do Not Disturb) for another Extension 

1. Click the "DND" button. 
2. Enter the Extension number. 
3. Click the "ENT" button. 

 
To cancel DND (Do Not Disturb) for another Extension 

1. Click the "DND" button. 
2. Enter the Extension number. 
3. Click the "FORC RLS" button or "ENT" button. 

 
 

3.25 Timed Do Not Disturb Registration/Cancellation 
Description 
The iPECS Attendant can regist or cancel Timed DND (Do-Not-Disturb) of other Extensions. 
CM system support timed DND service, so user can register DND by time. 

 
Operation 
To Activate Timed DND (Do Not Disturb) for another Extension 

1. Click the "Timed DND" button. 
2. Enter the Extension number. 
3. Enter the type of Timed DND. 
4. Enter the start time and end time. 
5. If the type is timed day, enter the day. 
6. Click the "Register" button. 

 
To cancel DND (Do Not Disturb) for another Extension 

1. Click the "Timed DND" button. 
2. Enter the Extension number. 
3. Click the "Delete" button. 

 
Conditions 

 
Related WMS Menu 
Data Management > Extension Information >Number(DN) Information > DN Feature Register 

1) DND Service Type 
2) DND Start Time 
3) DND End Time 

  
Relevant Features 

      DND 
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3.26 Follow Me Registration/Cancellation 
Description 
The iPECS Attendant can register or cancel Call forwarding for other extensions. 

 
Operation 
To register the CFWD for an extension 

1.  Click [CFWD] button. 
2. Enter a room number & Click the “Enter” key. 
3.  Select Call Forward Type(Unconditional, Busy, Noanswer, Busy or Noanswer). 
4.  Enter the Forwarded Number. 
5.  Click [add] button in the box. 

 
To cancel the CFWD for an extension 

1.  Click [CFWD] button.  
2.  Enter a room number & Click the “Enter” key.  
3.  Select Call Forward Type( Not Use).  
4.  Click [add] button in the box. 

 

Conditions 
 

Related WMS Menu 
Data Management > Station Information > Number (DN) Information > DN Feature Registration >  

1) Call Forward Type 
2) Call Forward Service Time 
3) Call Forward Destination (Phone No.) 
4) No Answer Forward Time (sec) 

 
Relevant Features 

      CFWD  
 

 

3.27  Noanswer Auto Call Hold 
Description 
When iPECS Attendant did not answer a call during Attendant No Answer Auto Hold Time (sec), 
The call automatically  placed on Hold and user listen hole tone.   
In case that  iPECS Attendant is assigned to multi ring service, the call is on hold  by multiple 
attendant. 
If one of iPECS Attendant answer the call, Other  hold queue is cleared automatically.  
In case of single ring service, support  services. When wating  queue is full,  the next call is 
released.  
When  user do not wait to use this feature,  assign  Attendant No Answer Auto Hold Time as 0 sec. 
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Operation 
To place a call on Hold automatically  

1. A user dial iPECS Attendant resentation number. 
2. iPECS Attendant did not answer a call during Attendant No Answer Auto Hold Time (sec). 
3. The call automatically  placed on Hold and user listen hole tone. 
4. iPECS Attendant answer the call,  Other  hold queue is cleared automatically. 

 
Conditions 
 Noanswer Auto Call Hold service is available when user calls attendant key number.  
 Noanswer Auto Call Hold service is automatically activated if the value of  timer is  more than 

1 sec. 
 

Related WMS Menu 
Data Management > Tenant Information > Tenant Time information > Attendant No Answer Auto 

Hold Time (sec) 
Data Management > Attendant Information > Attendant Call Options> Call Distribution to Multi 

Attendants 
 

Relevant Features 
       
 

3.28  Name Display 
Description 
In iPECS Attendant phone book , you can register first name, last name up to 50 characters. The 
Dial pad window & queue displays a name of  the active call.  
User can choose how to display first name & last name using  setting (Custom setting > Display 
option > Name View option) 
If the name has not been registered in the phone book, displays the system user name.(system 
user name is up to 48 characters). 
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Operation 
 

Conditions 
 

Related WMS Menu 
Data Management > Extension Information > Number(DN) information > DN Attribute > Name 
 
Relevant Features 
 

 

3.29  Wake-up Fail Notification 
Description 
If guest not answer the wakeup call, Notifying attendant of wakeup fail. If wake-up fail notification 
window pop-up, iPECS Attendant can call the guest or just confirm it. When there are multi-
attendant, iPECS-CM system send notification to the first available attendant. User can check 
wakeup-up alarm log in “Report and Statistics  > Alarm Call history ” menu in iPECS Attendant.  
 
Operation 
Register wakeup for a guset 

1. Guest not answer the wakeup call.  
2. wake-up fail notification window pop-up.  
3. iPECS Attendant call the guest. 

Or, iPECS Attendant just confirm it. 
 

Conditions 
 When there are multi attendant, send notification to the first available attendant. 

 
Related WMS Menu 
Data Management > Hotel Information > Hotel Extension Attribute  >Wakeup type / Wakeup-Date / 
Wakeup Time Relevant Features 
 
Relevant Features 
 

 

3.30 Emergency call  Notification 
Description 
If  subscriber guest dial emergency number, iPECS-CM system notifying attendant of emergency 
call. If emergency call notification window pop-up,  iPECS Attendant can call the subscriber or just 
confirm it. User can audit emergency log in “Report and Statistics > Alarm Call history ” menu in 
iPECS Attendant. 
 
Operation 

1. A subscriber dial emergency call. 
2. emergency call notification window pop-up.  
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3. iPECS Attendant call the subscriber. 
Or, iPECS Attendant just confirm it. 

 
Conditions 
 When there are multi attendant, send notification to the first available attendant. 

 
Related WMS Menu 
Data Management > System Feature Information > Emergency Code Table 
 
Relevant Features 
 

 

3.31  Noanswer recall indication 
Description 
When iPECS Attendant answer a recall (noanswer recall) , it displays recall information & 
noanswer number. 
 
Operation  
To register the CFWD for an extension 

1. Extension  A call a Attendant. 
2. Attendant answer the call and transfer to Extention B. 
3. Extension B do not answer the call.  
4. Extension  A recall  the Attendant. 
5. Attendant answer the call.  
6. Attendant displays recall reason & phone numbr on DialPad. 

 
Conditions 

 
Related WMS Menu 
 
Relevant Features 
 

 

3.32  Available Hunt Group member display 
Description 
When iPECS Attendant transfer a call to a busy subscriber, system displays the phone number  of       
another Idle subscriber  in same hunt group and call the idle subscriber automatically. It is 
displayed original dialed number and  transferred number on Dial pad.  This feature is available 
when subscribers are in the same hunt group.  
 
Operation 

1. Extension  A call a Attendant. 
2. Attendant answer the call and dial to Extention B in busy. 
3. Shows Extention B is busy state and shows available hunt group member. 
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4. To transfer the call to a available hunt group member, click [Connect] button in the box 
 

Conditions 
 This feature is avaible when subscribers are in the same hunt group 

 
 

Related WMS Menu 
Data Management > Group Information > Pilot Hunt Group  
 
Relevant Features 

Hunt service  
 

 

3.33  Final Call forward Destination Display 
Description 
When iPECS Attendant transfer a call to a forwarding registered subscriber, system find final 
available destination and display the call route.  In case of that call forwarding is registered in 
several steps, system find final detination subscriber and call subscriber automatically. This feature 
is available only when registered forwading to extension.  
 
Operation 

1. Extension  A call a Attendant. 
2. Attendant dial to Extention B registered CFWD(Extension B->C->D). 
3. Shows Extention A is registered forwarding state and shows final call forward destination. 
4. To transfer the call to Extention D, click [Connect] button in the box 

 
Conditions 
 This feature is available only when registered forwarding to extension. 
 iPECS Attendant display the call route up to ten step. 

 
Related WMS Menu 
Data Management > Station Information > Number (DN) Information > DN Feature Registration >  

1) Call Forward Type 
2) Call Forward Service Time 
3) Call Forward Destination (Phone No.) 
4) No Answer Forward Time (sec) 

 
Relevant Features 

      CFWD  
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3.34  Handset Link 
Description 
In case of iPECS Attendant, user can answer for incoming calls using desk phone handset and 
audio is only transmitted through the desk phone hanset, while the PC microphone and speaker 
are disabled. 
The desk phone is controlled by the soft phone, and the LCD display information of desk phone is 
displayed to soft phone LCD area. The desk phone function is limited to only audio transmission 
The user can not call using the dial pad of desk phone. 
When using other features (eg. conference) except for the basic call, phone link service is not  
Supported.  
 
Operation 

 
Conditions 
 When use handset link service for iPECS Attendant, automatic call recording is not supported. 

Only IP phone & Single line phone can be used for iPECS Attendant handset link service(SIP 
phone is not supported.) 

 
Related WMS Menu 
[To link Soft phone to Hard phone] 
Data Management > Extension Information > Terminal Information > Soft Phone Link 

 
Relevant Features 
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